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Copyright 

Copyright © 2005 - 2016 GMC-I Messtechnik GmbH 

These operating instructions, as well as the software described herein, are protected by copyright. 

Duplication of this document and/or the software is prohibited without previous express consent. 

Violators are liable for compensation of damages. 

All rights reserved. 

Trademark 

METRAwin 10® and METRAHIT® are registered trademarks of GMC-I Messtechnik GmbH. 

Products from other manufacturers are mentioned in these operating instructions for strictly 

informational purposes, and their mention does not represent any misuse of the respective 

trademarks. 

Exclusion of Liability 

The texts and illustrations included herein have been compiled with the greatest of care. Despite all 

of these efforts, errors can never be entirely prevented. For this reason, no guarantee can be made 

for the correctness of the contents of this document. We assume no legal responsibility or liability 

of any sort for incorrect entries or their consequences. We appreciate your suggestions for 

improvement, as well as any information regarding errors. 

We make every effort to keep these instructions up-to-date in accordance with the latest software 

version. It is nevertheless possible that differences may exist between the software and the 

instructions. Further information may be provided in a README.TXT file in your program directory. 

Subject to change without notice. 

Preface 
Contents of these 

Operating Instructions 

This document describes the specific functions of METRAwin 10 parameters 

configuring and analysis software in combination with METRAHIT Starline Series 

multimeters. Detailed information regarding the device functions is included in the 

operating instructions for each respective instrument. 

Use of the general functions of this software is described in a separate document 

which can be accessed by clicking Program Functions in the Help menu. 

 i  
Note on reading the document at your PC monitor with the help of Adobe Acrobat 

Reader™ 

The electronic version of this document may contain numerous cross-references with 

hyperlinks. For purposes of identification, these appear in blue with underlining, and simplify 

location of the texts to which reference is made. The monitor jumps to the referenced text 

after clicking the blue, underlined term. If you then wish to return to the previous text, use the 

[Alt+] key combination or click the symbol  (Previous View) in the Acrobat Reader tool 

bar. 

Target Group These instructions are intended for users of the software. 

The software is designed for use with the Microsoft Windows
®
 operating system. 

Users must be familiar with basic Windows
®
 functions. 

Scope of Validity These instructions are valid for METRAwin 10 version 6.20 or higher. 

 i  
Note  

The version number can be displayed by clicking About in the Help menu. 
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1 Features 

1.1 Scope of Functions 

 With the help of METRAwin 10 software, live or stored measurement data acquired 

with multimeters of the METRAHIT Starline Series and models METRAHIT WORLD 

and METRAport 40S can be read out, visualized, analyzed and documented. 

In addition to this, for most models present device settings can be queried, and the 

measuring functions and ranges which are available for the position to which the 

function selector switch is currently set can be remote controlled. For some models 

remote control of all functions is possible independent of the position of the function 

selector switch. Measurement data as well as device settings can be saved to 

specific files. 

In order to connect a METRAHIT Starline Series or METRAHIT WORLD multimeter 

to the PC, an interface adapter (optional accessory) is required. This connects the 

multimeter’s optical infrared interface to an available USB port at the PC via a cable 

with a length of approximately 1½ meters. Up to ten multimeters can be connected 

simultaneously with one adapter each.  

METRAport 40S can be connected directly to the USB ports by means of the 

provided USB cable, because here the IR-USB converter is already integrated. 

METRAHIT ULTRA BT can alternatively communicate wireless via Bluetooth
®
. 

Simultaneous communication with other types of multimeters is not possible. 

However, most memory data files (*.MDM) which have been separately read out of 

device memory from METRAHIT Starline Series and METRAHit 12-29S/M/C/I 

instruments can be combined and analyzed together. 

1.2 System Requirements 

 Refer to the description of the program functions in section 1.2 (Program Functions 

in the Help menu) for general requirements. 

Special requirements for the connection of multimeters:  

Hardware Requirements 

Computer 

 

1 free USB port per instrument with a load capacity of 50 mA for electrical power 

supplied via USB. 

For METRAHIT ULTRA BT: Integrated or external Bluetooth
®
 Interface 

Measuring Instruments 1 to 10 multimeters of METRAHIT Starline Series, METRAHIT WORLD or 

METRAport 40S; complete overview of models see coverpage 

Adapters Per multimeter 

METRAHIT Starline Series
*)
: “USB|X-TRA” IR-USB interface adapter (optional 

accessory); 

METRAHIT WORLD: “USB-HIT” IR-USB interface adapter (optional accessory); 

METRAport 40S: USB cable with plugs type A and type Mini-B (provided accessory). 

*)
 except  METRAHIT ULTRA BT, when communication via Bluetooth 

Software Requirements Installed METRAwin 10 software (version 6.20 or higher) with device drivers for 

METRAHIT Starline Series multimeters (MULTL_R.DLL). 

Installed device driver „GMC-I Driver Control“ for IR-USB interface adapter(s) 

USB|X-TRA, USB-HIT and multimeter METRAport 40S with assigned virtual COM 

port in the range COM1 ... COM256. 
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2 Initial Start-Up 

2.1 Setting Communication Parameters at the Multimeter 

 The following settings are important for communication between METRAwin 10 and 

the multimeter, and must be entered using the device’s setup menu. Please refer to 

the operating instructions for the multimeter for detailed information on how to set 

the device parameters. 

Infrared interface As long as the device is switched on, its infrared interface is ready to receive data 

and is capable of communicating with METRAwin 10. 

METRAHIT Starline Series In order to be able to “wake up” the device via the IR interface when switched off 

(e.g. after being shut down by the “auto power off” function), the IR standby function 

must be activated: 

 SETUP : SEt : irStb : ir on 

 The IR symbol appears in the upper right-hand corner of the display at the 

multimeter. 

The continuous transmission mode (Send) may not be activated, because measured 

values are polled from METRAwin 10: 

 SETUP : Send : Send oFF 

Bluetooth Interface 

(METRAHIT ULTRA BT only) 

The METRAHIT ULTRA BT has an infrared and a Bluetooth
®
 interface. But it can not 

communicate simultaneously over both interfaces. In the device setup menu, the 

interface to be used must be set: 

 SETUP : SEt : CoM : ir 

 Symbol „IR“ appears in the upper right corner of the multimeter display. 

 SETUP : SEt : CoM : bt 

 Symbol  appears in the upper right corner of the multimeter display. 

It is not possible to „wake up“ the unit via its Bluetooth
®
 interface. 

Device Address 

METRAHIT Starline Series 

With the exception of address 0 (= device does not respond to interface commands), the 

device address can be set as desired within a range of 1 to 15 (default setting after 

battery replacement is 15). If several multimeters are connected simultaneously, it is 

advisable to set the individual multimeters to different addresses, so that they can be 

readily identified when device settings are entered via METRAwin 10. 

 SETUP : SEt : Addr : 01 / 02/ … / 15 

The device address is irrelevant as far as assignment of the multimeters to 

measuring channels C1 through C10 in METRAwin 10 is concerned.  

 
Example Multimeter 

Device Address 
Adapter 
COM Port No. 

METRAwin 10 
Device Number/Meas. Channel 

Addr 15 (better: Addr 1) COM3 1 

Addr 3 (better: Addr 2) COM5 2 

Automatic PowerOff 

disable 

During computer controlled multimeter operation, it usually advisable to deactivate 

automatic device shutdown which is provided in order to extend the service life of the 

batteries: 

METRAHIT Starline Series  SETUP : SEt : APoFF : on 

 The ON symbol is displayed next to the battery symbol at the upper left-hand 

corner of the multimeter display. 

Depending upon the application, it may also be sufficient to select a long shutdown delay 

time (e.g. 30 minutes) and activate the infrared interface standby function (see above). 
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METRAHIT WORLD 

METRAport 40S 

 Hold the FUNC key pressed when switching on the device. 

 The  symbol is displayed at the upper left-hand corner of the multimeter 

display. 

 i  
Note (METRAHIT Starline Series only) 

Maximum operating time with new alkaline manganese batteries is 70 to 200 hours depending 

on multimeter model. The NA|X-TRA mains power pack (accessory) is recommended for 

long-term recording. 
 

2.2 Installing the USB Device Drivers 

 i  
Important Notes 

Install the USB device driver before you plug one of the adapters on the PC. Otherwise there 

is a risk that a wrong driver is installed by the automatic driver installation from Windows 

Update. 

Note that for the driver installation administrator rights will be required! 

 A CD ROM is provided with the adapter and with the multimeter METRAport 40S 

which includes the driver installer "GMC-I Driver Control" and the corresponding 

Installation Instructions. Both can also be found on the METRAwin 10 installation CD 

and on our website for free download: http://www.gossenmetrawatt.com > Products 

> Software > Software for Measuring Devices > Utilities > Driver Control 

 To install it, follow the steps described in the Installation Instructions. 

Driver Control installs the USB device drivers for almost all of our products with USB 

port. When connecting the device / adapter to an USB port the associated driver is 

loaded and Windows assigns to the device / adapter an individual, virtual COM port. 

 i  
Note 

You can check to make sure that installation has been successful in the Windows Device 

Manager, which also displays the COM port numbers which have been assigned to the 

adapters and must be in the range COM1 ... COM256: Click the Start button, and then 

Settings : Control Panel : System : Hardware : Device Manager 

 

http://www.gossenmetrawatt.com/
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2.3 Connecting the Multimeter to the PC 

2.3.1 Communication via USB 

 In order to connect a METRAHIT Starline Series or METRAHIT WORLD multimeter 

to the PC, an interface adapter (optional accessory) is required. This connects the 

multimeter’s optical infrared interface to an available USB port at the PC via a cable 

with a length of approximately 1½ meters. Up to 10 multimeters can be connected 

simultaneously with one adapter each. METRAport 40S multimeters can be 

connected directly to the USB ports by means of the provided USB cable, because 

here the IR-USB Converter is already integrated. 

Separate supply power is not required, because the adapter/converter is supplied 

with electrical power via the USB port. Maximum load placed upon USB supply 

power is 50 mA (typically 25 mA) per device. 

 i  
Notes 

If there is only one free USB port at the PC, then an usual USB Hub can be used to connect 

several multimeters. 

Maximum distance between the PC and the multimeter is restricted to approximately 1½ 

meters due to the length of the cable for the IR-USB interface adapter. USB extension cables 

and USB couplers for other communication systems (e.g. Ethernet, Bluetooth etc.) are 

available from commercial outlets, by means of which greater distances can be spanned 

either with a cable, or with a wireless connection. However, we have had no experience with 

systems of this type to date. 

The interface of the multimeters doesn’t use the IrDA protocol. Therefore a communication via 

an IrDA port of a PC is not possible. 

Ensure that the IR elements are not obscured by stickers on the upper end of the housing. 

  

Plug the Adapter/Cable to 

the Multimeter 
METRAHIT Starline Series  

 Insert the studs on the adapter USB|X-

TRA into the slots at the top of the 

multimeter so that the cable points to 

the right as seen from the front of the 

multimeter, and the socket for the 

power pack is not obstructed. 

Communication via the interface is only 

possible with the adapter in this 

position. 

The adapter can also be connected when the multimeter is in its protective rubber 

cover. 

 METRAHIT WORLD  

 Snap-on the adapter USB-HIT at the top of the multimeter 

as shown here.  
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  METRAport 40S 

 Plug-in the Mini-B connector 

of the supplied USB cable 

into the socket at the left side 

of the multimeter.  

 

 

Connecting the Adapter 

to the PC 

 Insert the adapter’s USB plug into a free USB port at the PC. 

 If the USB driver for the adapter/device has already been installed, this is now 

loaded by the Windows operating system and a virtual COM port is assigned 

to the adapter/device. 

 Else Windows reports that a new USB device has been found and will start 

driver installation. Cancel this and proceed as described in Section 2.2. 
 

2.3.2 Communication via Bluetooth (METRAHIT ULTRA BT only) 

 METRAHIT ULTRA BT can alternatively communicate via Bluetooth
®
 wirelessly over 

a distance up to 10 meters approx.. 

 i  
Notes 

When setting up a multi-channel measurement system with multiple METRAHIT Starline 

Series multimeters the communication links can also be mixed via Bluetooth and USB ports. 

If you want to include several METRAHIT ULTRA BT via Bluetooth in the measuring system, it 

is recommended to perform the steps described below with only one switched-on multimeter 

to identify the affected device unambiguously. 

  

Add Bluetooth  Device to 

Windows System 

 Ensure that the multimeter is switched on and its Bluetooth interface is activated 

(2.1) 

 Open the dialog window Add a device by clicking the Bluetooth Symbol  in the 

info area of the Windows taskbar or via Start : Control Panel : Hardware and 

Sound : Devices and Printers : (Bluetooth-)Gerät hinzufügen  

 The Windows system automatically searches for available devices and 

displays the devices found: 
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 Select the found METRAHIT ULTRA BT and then click [Next]. 

 In the following dialog box, enter the pairing code bt Pin you have set at the 

multimeter (default: 0000) and then click [Next]: 

 

 When the device has been added successfully, the following dialog box 

appears. Otherwise, follow the steps suggested by the Windows operating 

system. 
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Determining the 

assigned COM ports 

As the added BT ULTRA METRAHIT Multimeter(s) cannot directly be identified in 

the Windows Device Manager under Ports (COM & LPT), METRAwin 10 can not 

automatically find the device(s) when running the communication test. The following 

images show how you can determine the COM port(s) being assigned to the 

device(s) yourself: 

 

 

 

or 
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2.4 Executing the Communication Test 

 A communication test can be executed in order to test the connection between 

METRAwin 10 and the multimeter for correct functioning: 

 Switch the multimeter(s) on and select any desired measuring function. 

 Start METRAwin 10 and make sure that METRAHIT Starline Series is selected 

under Device Type in the Device menu. 

 Open the Communication Setup dialog box by clicking Communication in the 

Device menu. 

 When communicating with all multimeters via USB ports, then USB-COM can be 

selected as communication path. The program will then find itself all connected 

devices. 

If at least one METRAHIT ULTRA BT communicates via Bluetooth, you have to 

choose SEL-COM as the communication path and in the displayed list of COM 

ports being available in the Windows Device Manager you must check by yourself 

all COM ports to be used: 

   

 Start the communication test by clicking the [TEST] button. 

 Switched-off METRAHIT Starline Series multimeters with status IR Standby 

will now turn on automatically. 

 The  icon in the tool bar indicates active communication: 

green lamp on = PC is transmitting data to the device 

red lamp on = PC is receiving data from the device 

 If communication functions correctly, the measured quantities acquired from the 

multimeters, as well as their measuring channel assignments, are listed after a 

few seconds in the Input Test window under the Received Data heading. 

 

 METRAwin 10 Communication Setup  METRAwin 10 Communication Setup 
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 These are automatically activated as measuring channels in the Channels Setup 

dialog box after closing the window by clicking the [OK] button. 

 If data are not received correctly, “- - -” is displayed or an appropriate error message 

appears. If this is the case, check the above described parameter settings at the 

multimeter, and make sure that the adapters have been correctly connected and that 

their drivers have been installed. 

 i  
Notes 

The elements in the Communication Setup dialog box are identical to those in the Input 

Setup section of the Channels Setup dialog box, by means of which the communication test 

can also be executed. 

In the measuring functions Power and Harmonics the METRAHIT ENERGY multimeters send 

nine measurands simultaneously. In order to recognize that all devices communicate, when 

several devices are connected, it is recommended, not to use these functions for the 

communication test. 
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3 Operation 

3.1 Online Recording of Live Measurement Data 

 Before starting online recording, be sure to read all of the applicable notes included 

in the description of the Program Functions in section 3.5.2 regarding the Start 

Online Recording function in the File menu. 

The following specific operating parameters and conditions apply to recording 

currently measured live data from the connected METRAHIT Starline Series 

multimeters to the PC by means of METRAwin 10: 

Number of Channels Up to ten multimeters can be connected to the PC, to which active measuring 

channels C1 through C10 will be assigned (in ascending order based on the COM 

port numbers assigned to the adapters). 

Sampling Interval The shortest selectable sampling interval is 1 second. 

 i  
Notes 

METRAHIT Starline Series with memory only: Measured values can be stored to memory 

at the multimeters at a minimum sampling interval of 0.1 seconds. 

METRAHIT ENERGY only: Measured DC values can be stored to memory at the multimeters 

at a minimum sampling interval of 0.5 milliseconds.. 

Measuring Function  

METRAHIT ULTRA 

METRAHIT ENERGY 

METRAHIT MULTICAL 

With these models all measuring functions and ranges can be set under Device : 

Setup Device in METRAwin 10 independent of the position of the function selector 

switch. 

METRAHIT Starline Series Switching amongst the measuring functions and ranges available for each respective 

selector switch position is possible under Device : Setup Device in METRAwin 10. 

METRAHIT WORLD 

METRAport 40S 

The desired measuring function must be selected manually with the function selector 

switch and FUNC key at the multimeter. 

Measuring Range As is the case with all devices which are equipped with auto-ranging, it is advisable to 

deactivate this function and to work with an adequately large, fixed measuring range. 

Erroneous measured values and/or recording gaps may otherwise occur as a result 

of range switching. This applies to recordings in device memory as well (4.2). 

Channels Setup  Before you start online-recording, execute a communication test by clicking 

[TEST] in the dialog window Channels Setup.  

 The measured parameters being available at the connected multimeters will 

be detected and entered as Active Channels.  

 

 METRAwin 10  Channels Setup 
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 If this automatic setting of the channels is not what you want, you can enable or 

disable channels or assign them to another device or another measured 

parameter. 

METRAHIT ENERGY With this multimeter multiple measurands are available in power measuring function 

(W) and in harmonics analysis ( ). 

The following nine measurands are available in power measuring mode: 

P Active Power S Apparent Power 

Q Reactive Power PF Power Factor 

U Voltage I Current 

E-P Active Energy E-S Apparent Energy 

E-Q Reactice Energy 

 

The measured parameters of harmonic analysis can also be read completely and 

displayed as a frequency spectrum:  

 Before you start online recording, select FFT Bargraph  in the View menu. 

 When online record is started, the Total Harmonic Distortion THD, the 

Fundamental component H01 and the individual Harmonics H02 through H15 

are displayed in two bar charts: above as a relative value in % (based on the 

fundamental), below as absolute magnitudes in Volts or Amps. 

 
These values are updated every 5s, but not recorded continuously. After 

finishing the measurement, the last read data can be stored as a snapshot. 

 

 METRAwin 10  Channels Setup 
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3.2 Reading Out and Visualizing Stored Data 

 Proceed as follows in order to read out and visualize measurements which have 

been recorded to memory at METRAHIT Starline Series multimeters: 

 i  
Note 

 

Device : Read Memory 

 [ F5] 

 Open the Read Device Memory dialog box by clicking Read Memory in the 

Device menu. 

 

The fields and buttons in this dialog box have the following functions: 

COM Port: As the communication path here is given the setting that you have made under 

Device : Communication (2.4). 

Get Memory Info Starts a search for connected multimeters and queries their memory occupancy. The 

results are displayed in the Info fields. 

Move Memory Data to File Open the Save as dialog box in order to select a directory path and enter a filename 

for the memory data file to which the memory contents from the selected devices will 

be saved after clicking the [Save] button. The file type for memory data from these 

multimeters is always pre-specified as MDM. 

Progress is displayed in the information bar at the main program window during 

read-out. 

Open Memory Data File The above described files can be opened again later by clicking this button. 

The button has the same function as the Memory Data File item under Open File in 

the File menu, which is described in detail in section 3.5.2 under Program 

Functions in the Help menu. 

Add Memory Data File An additional memory data file can be added to an already open memory data file by 

clicking this button. This may also be the already opened file, for example if it 

contains several recordings. 

 i  
Note 

Memory data files read out individually from device memory at METRAHIT Starline Series and 

METRAHit 12-29S/M/C/I multimeters can be combined with this function, so that they can be 

analyzed together. 
 

 METRAwin 10 Read Device Memory 
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Display Data from File After memory read-out has been completed, or memory data files have been opened 

or added, the measuring modes and recording start times are displayed in the Info 

fields for the recordings (data blocks) which are contained in the respective 

multimeter’s memory. 

 

 Select the recording(s) being desired for analysis. 

 Then click the [Display Data from File] button. 

 If at least one of the recordings contains several measurands, then a dialog 

box opens for Selecting channels to read: 

 
All available measurands are listed here from which up to 10 can be selected 

as channels to be displayed by clicking with the mouse whilst holding the [Ctrl] 

key pressed. Confirm your selection with [OK]. 

 Measured values from the selected recording(s) or measured quantity(ies) 

appear at the monitor and can be analyzed, edited and printed in various 

views, and finally saved together to a common measurement data file (*.MDF). 

Create all intermediate 

samples 

This checkbox is relevant only to memory data from METRAHIT ENERGY 

multimeters. If data have been recorded using “Hysteresis”, then the samples have 

unequal time distance. By checking this box, the software will create all intermediate 

samples by interpolation according to the used interval setting. 

 METRAwin 10 Read Device Memory 

 METRAwin 10 Select channels to read 
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3.3 Device Settings via the Interface 

METRAHIT ULTRA 

METRAHIT ENERGY 

METRAHIT MULTICAL 

With these devices all measuring functions and ranges can be set independent of 

the position of the function selector switch. The source functions of METRAHIT 

MULTICAL cannot be controlled by METRAwin 10. 

METRAHIT WORLD 

METRAport 40S 

For these multimeters reading or remote control of the device setting is not available. 

The desired measuring function must be selected manually with the function selector 

switch and FUNC key at the multimeter. 

METRAHIT Starline Series The measuring functions and ranges which are available for the position to which the 

function selector switch is currently set can be remote controlled with METRAwin 10. 

Device : Setup Device  

 

 Open the Device Setup dialog box by clicking Setup Device in the Device 

menu, by means of which remote control of the devices is possible. 

 

The fields and buttons in this dialog box have the following functions: 

Search Starts a search for connected multimeters. The following is displayed in the 

Connection section after a few seconds:  

 The number of detected devices (2 in the example shown above) 

 The selected device address for this device (5 in the example shown above) 

 The device type of the multimeter with the currently selected address 

Read In Reads in current settings and status information from the multimeter with the 

currently selected address, and displays them: 

The following status information is available and will be updated every 5 seconds: 

 Current Time from the real-time clock at the Device and the PC 

 Firmware version of the operating software installed to the device 

 Battery voltage in V 

 Memory Occupancy as a percentage (%)
*)
 

 Recording status: if recording is currently in progress, the LED symbol next to the 

memory occupancy field blinks
*)
 

*)
 if the multimeter has this feature  

Send Params. Transmits the device setting parameters displayed in the Parameters section to the 

selected device, or to all multimeters of the same type. 
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METRAHIT Starline Series If the function selector switch at the device is set to a position for which the desired 

measuring function is not available, a corresponding message is displayed and the 

user is prompted to set the switch to the appropriate position. 

ZERO/REL on Activates zero offset / relative measurements for the multimeter with the currently 

selected device address. From this point on, the value measured by the multimeter 

at this moment (< 50% of the measuring range!) is subtracted from measurements 

performed with this function. 

ZERO/REL off Deactivates zero offset / relative measurements for the multimeter with the currently 

selected device address. 

Start Memory Starts recording of measurement data to multimeter memory. 

Stop Memory Stops recording of measurement data to multimeter memory. 

Clear Memory Deletes recorded measurement data from multimeter memory. 

Personalize... Opens the dialog box Personalize Device: 

 

Up to 6 characters text (name, department, etc.) can be entered here and sent to the 

device. This text is displayed permanently at the turned-off device when the IR port is 

in standby mode (SEt> IrStb on). Otherwise, it appears only briefly when switching off. 

Send Time Synchronizes the real-time clock at the currently selected device with PC system time. 

Send Time to All Synchronizes the real-time clocks at all connected devices with PC system time. The 

time difference after synchronization is max. 0.1 s. The drift of the clocks at a 

constant temperature can be ± 2s/day. The temperature effect is 50 ppm/K. At 10°C 

temperature difference equivalent to about 40s/day. 

Setup Files Save 

 

Open 

Saves currently displayed parameters to a specific device setup file (*.xtr / *.kmm / 

*.xis / *.xss / *.hxx / *.hxb / *.hxs / *.hxt / *.xme / *.xmc / *.xmu / *.xml) for reuse. 

Opens a dialog box for selection and read-in of a previously stored device setup file. 

 
 

 Open 
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Parameters The settings for the following device Parameters are given and can be changed and 

then sent to the device or stored in a file. Detailed descriptions of these parameters 

and their functions, as well as their setting ranges, are included in the operating 

instructions for the respective devices. 

 Meas. Mode 

 Meas. Range 

 Storage Rate 
*)
 

 Current Clamp Factor 
*)
 (when Meas. Mode = ...CLIP) 

Transformation ratio of the connected current transformer/sensor: 

 Current probe with  current output, e.g. 1mA/A  1:1000 

 Current sensor with voltage output, e.g. 100mV/A  1:10 

 Cable Capacitance Constant 
*) 

required for the cable length measuring mode m 

 dB-ref 
*) 

Reference value in Volts for ratio measuring mode dB (AC voltage levels) 

 Short-limit 
*) 

Limit value in Ohms for continuity measuring mode Beeper, below 

which the acoustic signal sounds 

 i  
Note 

If measurement data are to be recorded (either online to the PC or offline to device memory), 

a fixed measuring range should always be used, because erroneous measurements may 

otherwise occur during automatic measuring range selection (auto-ranging). 

Temp. Sensor... Opens the dialog box Temperature sensor setup with the following options: 

 Selection of Sensor type 

 Setting the Lead resistance for Pt100 sensor 

 Selection of temperature Unit 

Trigger... *) Opens the dialog box Trigger setup with the following options: 

 
In Storage Trigger segment: 

 Hysteresis: Minimum required change of measured value (in digits) in order to be 

recorded. 

 Trigger mode:  

> STORE-IN  only values inside the range between Low level and High level 

(in digits) will be stored; 

> STORE-OUT  only values outside the range between Low level and High 

level (in digits) will be stored. 

 Storing time: Defines the maximum duration for which the measured values will 

be recorded after meeting the trigger condition. 

In Event Trigger segment: 

 Low level and High level define the trigger levels for the event counter measuring 

modes Events DC and Events AC. 
   *)

 if the multimeter has this feature 
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Energy...*) Opens the dialog box Power Storing Setup: 

 
With parameter Mode you can select which type of measured values shall be 

recorded in Power measuring mode when storing is activated: 

> NORMAL: The instantaneous values of current, voltage, active, reactive and 

apparent power and power factor will be registered according to the selected 

Storage rate ( 0.5 s). 

> DEMAND: Always at the end of the time period being specified by parameter 

Demand time, the average values of active, reactive and apparent power will be 

registered. 

> ALL: All the above values will be stored. 

Mains... *) Opens the dialog box Mains setup: 

 

 Frequency [50 Hz / 60 Hz]: Selection of the nominal frequency of the mains 

voltage to be monitored is required for the calculation of the half-cycle TRMS 

value. Selection is irrelevant for DC signals. 

 Range [6,0000 V / 60,000 V / 600,00 V]: A fixed voltage measuring range must be 

selected for this function. 

 Low voltage limit [00000 ... 20700 ... 60000 digits] and 

High voltage limit [00000 ... 25300 ... 60000 digits] define the tolerance band for 

under/over voltage detection based on the continuously recorded V ACDC value. 

 Dip limit [00000 ... 20700 ... 60000 digits] and 

Swell limit [00000 ... 25300 ... 60000 digits] define the thresholds for detection 

and event triggered recording of short voltage dips and swells based on the half-

cycle TRMS value. 

 Peak limit [00000 ... 50000 ... 100000 digits] defines the absolute threshold value 

for detection and event triggered recording of voltage waveform peaks (>1ms 

duration) based on the sampled voltage signal (1.2 kS/s). 

 Transient limit [200 ... 600 V] defines the trigger magnitude for detection and 

event triggered recording of voltage transients (0.5 ...5µs duration) relative to the 

momentary waveform value. 
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Harmonics... *) Opens the dialog box Harmonics Setup: 

 

 Frequency [16,7 / 50 / 60 / 400 Hz]: In order to analyze the measuring signal’s 

harmonics, its fundamental frequency must be specified with this parameter. 

 Voltage range [600 mV / 6 V / 60 V / 600V / Auto] and  

Current range [600 µA / 60 mA / 600 mA / 6 A / 10 A / Auto]: Due to the fact that 

at the device the MAN/AUTO key is used for another purpose in the harmonic 

analysis function, it cannot be used to switch back and forth between automatic 

and manual range selection. For this reason, these parameters are used to 

specify a measuring range for harmonic analysis. 

 
*)

 if the multimeter has this feature
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4 Appendix 

4.1 Schematic Diagram of Program Functions 
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4.2 Examples of Measurement Data 

METRAwin 10 contains some sample data files for these multimeter types: 

DEMO_R1.MDF Rectangular signal recorded in the device memory with automatic and fixed 

measuring range selection. 

It is shown here that automatic range selection can result in false values and 

therefore data should be recorded with a fixed range if possible. 

 
 

DEMO_R2.MDF This measurement example shows the synchronicity of channels for simultaneous 

online recording of the measured values of three multimeters.  
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DEMO_R3.MDF This example shows that at low measurement signal in the ACDC and AC 

measurement functions longer setting times are resulting from the TRMS converter.  

 
 

DEMO_R4.MDF In this example, two METRAHIT ENERGY multimeters have been used to record 

online various power parameters simultaneously at the AC input and DC output of a 

power supply. By means of the Equation Editor the efficiency eta = output active 

power / input active power is calculated and displayed in the XY view mode as a 

function of the extracted output power. 
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DEMO_R5.MDF In this example, the measurement data of the harmonic analysis have been read 

online from a METRAHIT ENERGY multimeter and are displayed in view mode FFT 

Bargraph. It shows the snapshot of the spectrum of the voltage harmonics of a 

square wave signal, in the upper diagram with relative values (in% of fundamental) 

and in the bottom graph with absolute values (in volts).  

 
 

DEMO_R6.MDF The file shows data of a mains voltage monitoring recorded by METRAHIT ENERGY 

in the function PQ Mains, with short voltage dips and swells as well as peaks and 

spikes (transients). To see the details, zoom in by stretching the time axis. The used 

device settings can be found in the Device Setup file PQ Mains.XME. 
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